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MARKING SCHEME 

SECTION A: OBJECTIVE TYPE QUESTIONS 

 

Q.(1) Answer any 4 out of the given 6 questions on Employability Skills.                    (4 x 1 = 4) 

(i) A group of words that just give some hint of the idea contained in a message is a . 

(a) Phrase  (b) Clause  (c) Sentence  (d) Paragraph 

(ii) Internal stress is a result of : 

(a) Pent-up worries    (b) Rat race   

(c) Laziness     (d) Noise 

(iii) Your ability to identify effective methods of getting yourself to move from thought to 

action is your :  

(a) Self-regulation    (b) Self-motivation   

(c) Self-dedication    (d) Self-awareness 

(iv) What kind of software seems useful in the beginning, but will cause damage to the 

computer once installed ?  

(a) Worm  (b) Virus   (c) Trojan Horse (d) Spyware   

General Instructions: 

1. Please read the instructions carefully. 

2. This Question Paper consists of 21 questions in two sections: Section A & Section B. 

3. Section A has Objective type questions whereas Section B contains Subjective type questions. 

4. Out of the given (5+16=) 21 questions, a candidate has to answer, (5+10=) 15 questions in the 

allotted (maximum) time of 2 hours.  

5. All questions of a particular section must be attempted in the correct order. 

6. SECTION A - OBJECTIVE TYPE QUESTIONS (24 MARKS): 

i. This section has 05 questions. 

ii. Marks allotted are mentioned against each question/part. 

iii. There is no negative marking. 

iv. Do as per the instructions given. 

7. SECTION B – SUBJECTIVE TYPE QUESTIONS (26 MARKS): 

i. This section has 16 questions. 

ii. A candidate has to do 10 questions. 

iii. Do as per the instructions given. 

iv. Marks allotted are mentioned against each question/part. 

 

8. Marks allotted are mentioned against each question/part. 
 



CL_X_PRE BOARD I_IT(402)_MS_ 2 / 8 
 

(v) ‘An entrepreneur has to get the work done through others’. Which characteristic of the 

entrepreneur does this statement depict? 

(a) Innovativeness (b) Motivator  (c) Organiser  (d) Risk Taker 

(vi) UN Sustainable Development Summit (2015) set up development goals called as    

(a) Agenda 2010    (b) Agenda 2030   

(c) Agenda 2050    (d) Agenda 2020 

Q.(2) Answer any 5 out of the given 6 questions.                                                             (5 x 1 = 5) 

(i) Samyak is working in Writer. He wants to learn the ways to launch the Drawing tool bar, if       

     not available on the interface. Help him to do so.  

(a) View>Toolbars>Drawing  

(b) Insert>Drawing  

(c) Insert>Group>Drawing   

(d) View>Group>Drawing  

(ii) Dhanush wants to select the entire text in a document. Which key combination he should use 

to do the same ?   

(a) Ctrl + R  (b) Ctrl + A  (c) Ctrl + V  (d) Ctrl + S 

(iii) After the document is modified, clicking on which option will update the TOC ?   

(a) Delete Index/Table    (b) Update Index/Table   

(c) Modify Index/Table   (d) None 

(iv) Which toolbar is by default placed below the menu bar? 

(a) Title  (b) Formatting  (c) Picture  (d) Standard 

(v) What is the shortcut to bring up the style and formatting window in Writer? 

(b) Ctrl+F1  (b) Ctrl+F5  (c) F11   (d) Ctrl+F12 

(vi) Ishita had drawn a few shapes in her document. She wants to use the same formatting in all 

the shapes in one go. Which feature she should use to do the same ? 

(a) Arranging  (b) Shifting  (c) Grouping  (d) Aligning 

Q.(3) Answer any 5 out of the given 6 questions.                                                             (5 x 1 = 5) 

(i) Which of the following is a correct way to refer to a cell in Calc ?   

(a) <Sheet name>.<Row name>  (b) <Sheet name>.<Column name>   

(c) <Sheet name>.<Cell reference>  (d) None 

(ii) Amir was working in a file of spreadsheet software. His friend was also working in the 

same file, but Amir wants to know what changes had been done by him. What feature does 

he use to track the changes done by his friend ?      

(a)  Comment  (b) Track changes (c) Resolve conflicts (d) Accepting changes 

(iii) Anikan wants to know the name given to the mathematical expression to perform 

calculation on data in cells. Help him to find the correct answer.      

(a) Goal Seek  (b) Macro   (c) Formula  (d) Subtotal   
(iv) Reena is curious to know as what cells can hold as the individual elements. Answer to her 

question. 

(a) Text  (b) Numbers  (c) Formulas  (d) All of these 

(v) Lalit wants to know the name of the menu/tab used to create subtotals in a spreadsheet      

      application. Answer to his query. 

(a) Data Menu/Tab (b) Edit Menu/Tab (c) Layout Menu/Tab (d) Tools menu/Tab 

      .(vi)  Alaya wants to know the keyboard shortcut that brings up the Function Wizard. Answer to      

               her by selecting the correct option.       

(a) Ctrl+F1  (b) Ctrl+F2   (c) Ctrl+F3  (d) Ctrl+F4   
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Q.(4) Answer any 5 out of the given 6 questions.                                                             (5 x 1 = 5) 

(i) Rishabh wants to know about the full form of the term RDBMS. Suggest to him the correct     

     expanded form of the same.  

 (a) Rational Database Management System 

  (b) Relational Database Management System 

   (c) Redundant Database Management System 

  (d) None of these 

(ii)  Multiple copies of the same file leads to ………………..     

(a) Data inconsistency    (b) Data redundancy  

(c) Data consistency    (d) Foreign key 

(iii) COMMIT and ROLLBACK commands are of which type ?     

(a) DML  (b) TCL  (c) SQL  (d) None 

(iv) Bhabesh wants to know the full form on DCL. Help him to find the correct option. 

(a) Data Control language    (b) Data Constraint Language 

(c) Data Case Language   (d) Datum Case Language  

(v) Which data type shows value in the form of True or False ?  

(a) Boolean  (b) Integer  (c) Real  (d) Float 

(vi) To modify the data type of a column in table, which command and keyword is used? 

(a) Create, change (b) Alter, modify  (c) drop, change  (d) None  

  
Q.(5) Answer any 5 out of the given 6 questions.                                                             (5 x 1 = 5) 

(i) Dinka was attending a fire drill at her school. She wants to know in event of fire in a   

     building, what should be used instead of elevator. Answer to her query.     

(a) Office space (b) Washroom  (c) Staircase  (d) Elevator 

(ii) Class A fires are caused by :      

(a) Wood, paper cloth etc.   (b) Gasoline, propane and solvents  

(c) Magnesium, lithium and titanium  (d) All of the above 

(iii) Monika wants to know the name of hazard caused by repetitive movements, improper setup    

       of work station. Answer to her query. 

(a) Psychological hazard   (b) Physical hazard  

     (c) Chemical hazard    (d) Ergonomic hazard 

(iv) Which of the following is suggested in case of minor burns ? 

(a) Apply hot water  

(b) Run cool water over the affected area for up to 15 minutes  

     (c) Both of the above    (d) None of these 
(v) Which type of hazard can cause skin irritation, illness or breathing problems ? 

(a) Chemical hazard    (b) Slipping hazard  

     (c) Biological hazard    (d) None of these 
 (vi) Which of the following falls in the category of emergency ? 

(a)  Earthquake     (b) Tornadoes   
(c) None of the above    (d) Both (a) and (b)  
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SECTION B: SUBJECTIVE TYPE QUESTIONS 

Answer any 3 out of the given 5 questions on Employability Skills                                (3 x 2 = 6)  

 

Q. (6) What measures could be taken to overcome communication barriers ? Explain any four.    

Ans. :  

Never go unprepared : The lack of prepration results either from the scarcity of relevant 

information about a topic or an incorrect audience analysis. 

Give required time : In the present day life, time is always at a premium and if the sender of the 

message compromises by not giving the required for preparation of the message, the receiver is sure 

to face problems.  

Don’t be overconfident : When a person a sender or a receiver thinks that he knows all about a 

subject, he runs the risk of overconfidence.  

Don’t be apathetic : Apathy causes communication to break down because it interrupts effective 

listening. It is for this reason that an apathetic speaker does not relate information well and may 

leave out key points. 

Work on language competency to overcome linguistic deficiency :  

Avoid false assumptions : 

Don’t be fearful and defensive : 

Don’t be egocentric : 

Avoid judgemental attitude : 

Show respect towards the receiver of the message : 

 

Q. (7) Briefly explain four ways to identify the cause(source) of stress. 

Ans. : 

(i) Survival Stress : It is generated bt do or die crisis. 

(ii) Internal Stress : It is generated by pent up worries. 

(iii) Environmental stress : It is generated by the uncomfortable feeling of things in the 

surroundings. 

(iv)  Fatigue or overwork related stress : It is generated by the fatigue and overwork. 

 

Q. (8) What is an antivirus ? Name any four antivirus programs. 

Ans. : : It is often installed on the computer to prevent presence of any virus on the computer. Eg. : 

McAfee, Symantec, Kasperskey, Norton 

 

Q. (9) Describe advantages and disadvantages of entrepreneurship as a career. (two each) 

Ans. : Advantages : Independence, Ambition fulfilment, Excitement, Freedom, Wealth creation, 

Status 

Disadvantages : Risk, Hard work, Uncertain income, Problem of finance, Incompetent staff 

Independence : An entrepreneur is his own boss. He can take all decisions himself. 

Freedom : Entrepreneurship allows the freedom to try out one’s ideas. Freedom seeking people 

choose entrepreneurship as a career. 

Risk : It involves considerable risk of loss. Failure can wipe away all the personal savings and lead 

to considerable debt burden. 

Problem of finance : Raising the necessary funds is very difficult for a first generation entrepreneur. 

 

 

 

 



CL_X_PRE BOARD I_IT(402)_MS_ 5 / 8 
 

Q. (10) Describe sustainable development. Write any two long-term solutions to sustainable   

            development.  

Ans. : Sustainable development is a systematic approach to growth and development and to manage 

natural, produced and social capital for the welfare of their own and future generations.  

(i) Govt must take recourse to legal framework and policy making to stop illegal activities. 

(ii) Awareness and responsibility campaigns intended for farmers and industralists. 

(iii) Protection of ecology through taxes and fines. 

(iv) More and more emphasis should be on development od sustainable agriculture. 

Answer any 4 out of the given 6 questions on Subject Specific Skills.                            (4 x 2 = 8) 

Q. (11) Explain the following anchoring options for a picture :  

 (a) To character   (b) To paragraph 

Ans. : 

(a) To character : Frame is with its X and Y coordinates associated to a character, for example in 

the X direction always to the margin and in the Y direction always to the height of the character. 

The frame should be set at flow. 

(b) To paragraph : Frame is associated to a paragraph, change its position with the paragraph. 

 

Q. (12) Distinguish between the following with respect to spreadsheets (Answer any one) 

 i. Relative and Absolute Hyperlink 

 ii. Internet Hyperlink and Document Hyperlink 

Ans. : 

Hyperlinks can be used in Calc to jump to a different location from within a spreadsheet and can 

lead to other parts of the current file, to different files or even to websites.  

i.  

Relative Hyperlink Absolute Hyperlink 

A relative link will stop working only if the start 

and target locations change relative to each 

other. 

A absolute link will stop working only if the 

target is moved. 

A relative hyperlink is hyperlink that contains an 

address that is relative to the address of the 

destination file. 

An absolute hyperlink is a hyperlink that 

contains the full address of the destination file of 

the website. 

In relative hyperlink, the files should be in the 

same order. 

In absolute hyperlink, the files can be stored 

anywhere in the system. 

 

ii. Document hyperlinks are used to connect content within a specific document or on a local 

network. While Internet hyperlinks connect content across the global network of the World Wide 

Web. 

 

Q. (13) What is cell referencing ? Explain different types of cell referencing used in spreadsheet.  

Ans. ; 

The cell addresses in a formula are known as cell referencing. It means how a cell address behaves 

in the formulae when it is copied from one cell to the other. 

Relative cell referencing : It is normal cell address like A1, C3. In this, the formulae in the copied 

cell changes according to the change in the position of the cell pointer. Eg.: =B3*C3 
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Absolute cell referencing : It is specified by using $ sign along with the column and the row 

number in the cell. Eg. $B$4.  

Mixed cell referencing : It is when one part of the cell address is relative and the other is absolute. 

So, either the column or the row number should have a $ along with it. Eg.: $B3 

 

Q. (14) Explain any four advantages of DBMS.  

Ans. : Database Management System. It is collection of inter related data and a set of programs to 

access those data.  

Advantages : Sharing of data, Data redundancy, Data inconsistency, Confidentiality, Highly 

securable  

Sharing of data : Different users can use the same database to access the data according to their 

needs. 

Data redundancy : It means duplication of data. It avoids duplication of data and ensures that there 

is only one instance of certain data. 

Data inconsistency : It helps to avoid data inconsistency. It means if a single database is used by 

multiple users then it also ensures that the same data is present for all the users.  

Confidentiality : It can ensure different views for the different users of the database. This keeps the 

confidentiality of the data safe. 

 

Q. (15) What is hazard ? Explain any two types of hazards. 

Ans. : A hazard is any source of potential damage, harm or adverse health effects of the people at 

workplace. Hazard is a potential source of harm to the health of the worker or employee.   

Biological hazards : It is caused by bacteria, viruses, insects, plants, birds, animals and humans. It 

includes exposure to harm or disease associated with working with animals, people or infectious 

plant materials. 

Chemical hazards : It depends on the physical, chemical and toxic properties of the chemical in 

any form. This type of hazards can cause skin irritation, illness or breathing problems.  

Ergonomic hazards : It is caused by repetitive moments, improper setup of workstation etc. It 

normally occurs when the type of work, body posture and working conditions put a strain on your 

body. 

Physical hazards : It can be any factors within the environment that can harm the body without 

necessarily touching it.  

Safety hazards : These are caused by unsafe working conditions that can result in injury, illness 

and death. Safety hazards are the most common workplace hazards. It is caused by slipping hazards, 

tripping hazards etc. 

Psychosocial hazards : It is caused by stress, violence etc. at workplace. This type of hazard can be 

caused by unwanted stress of work completion on time, quarrelling, violence or fights with 

colleagues, lack of control and respect etc.   

 

Q. (16) Write any 8 precautions that are to be taken at the workplace.  

Ans. : Your safety is your personal responsibility 

Always follow the correct procedures 

Never take shortcuts 

Take responsibility and clean up if you made a mess 

Clean and organize your workspace 

Ensure a clear and easy route to emergency exits and equipment 
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Answer any 3 out of the given 5 questions on Subject Specific Skills.                          (3 x 4 = 12) 

Q.(17) What is a style ? Explain different types of styles which can be provided in a Writer. 

Ans. : It is a combination of font effects, colours and background such that it can be saved and 

applied whenever needed into the writer document. Writer come with predefined styles for all 

document types. It has five style categories : 

(i) Paragrapg style : It affect entire paragraphs represented with those styles. 

(ii) Character styles : It affect a block of text inside a paragraph. 

(iii) Frame style : It affect frames and graphics 

(iv) Page styles : It affect page formatting (page size, margin and link) 

(v) List styles : It affect outlines, numbered lists and bulleted lists. 

 

Q.(18) Anshita is preparing spreadsheet notes for her term exam. Help her to write short note on the   

            following. Give suitable example of each. 

(a) Subtotals  (b) Consolidate   (c) Goal seek  (d) Scenarios 

Ans. : 

(a) Subtotals : The subtotal feature in spreadsheet helps to use statistical functions (sum, average, 

count, min, max, product) on the group of data repeatedly in one column. It helps to manage, 

analyse and extract specific information from the data. 

(b) Consolidating data : We can summarise data from multiple worksheets into one worksheet or 

master worksheet. The consolidated worksheet can be in the same workbook or can be on another 

workbook. If you have consolidated it, you can update one or more workbook, the updating will 

automatically be reflected in the consolidated workbook. 

(c) Goal Seek : Goal Seek is the process of finding the correct input value when only the output is 

known. 

Tools-> Goal Seek 

.(d) Scenarios- A Scenario is a set of values that Excel saves and can substitute automatically on 

your worksheet. You can create and save different groups of values as scenarios and then 

switch between these scenarios to view the different results. 

The scenario feature of Calc is used to test 'what if' (How a given situation might be 

handled) questions by allowing users to create and save multiple sets of input values for a 

given set of calculations, and compare the outcomes of different scenarios. 

 

Q.(19) Define Referential integrity with example. Explain different types of relationship between    

            tables by giving suitable example of each.   

Ans. : Referential integrity refers to the relationship between tables. Because each table in a 

database must have a primary key, this primary key can appear in other tables because of its 

relationship to data within those tables. When a primary key from one table appears in another 

table, it is called a foreign key. It means the reference from a row in one table to another table must 

be valid. It requires that a foreign key must have a matching primary key or it must be null.   

 

There are three types of reletionships which can be created in tables : 

(a) 1:1 (one to one) : : In this relationship, both the tables must have primary key columns. Eg. 

Roll number to address  

(b) 1:n (one to many) : In this relationship, one of the tables must have primary key column. It 

signifies that one column of primary key table is associated with all the columns of 

associated table. Eg. Student to subjects/teachers  

(c) m:n (many to many) : In this relationship, one of the tables must have primary key column. 

It signifies that all the columns of primary key table is associated with one column of 

associated table. Eg.  Student and class teacher  
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Q.(20) Consider the following table : Sales    

Sale_ID Prod_Name Price Discount 

1101 Laptop 65000 2500 

1103 Pen tab 29500 1000 

1105 Desktop 50000 1550 

1106 Printer 12000 2000 

 

(a) How many fields and records are there in Sales table ? 

(b) Write SQL commands for the following : 

(i) Display Sales ID and Price of all products whose discount is more than 1000. 

(ii) Display the details alphabetically by product name. 

(iii) Display product name and sales price after deducting the discount from the 

price.  

Ans. : 

(a) Four fields and four records. 

(b)  

(i) select Sale_ID, Price from Sales where Discount>1000; 

(ii) select * from Sales order by Prod_Name; 

(iii)  select * from Sales; 

 

 

Q.(21) Explain any four ways through which one can maintain a healthy body at workplace.  

Ans. : 

.(i) Watch your plate : Promote consumption of a variety of foods. 

(ii) Watch your waist and weight : Encourage the use of weighing scale. Measuring tapes and 

devices to monitor individual physical fitness. 

.(iii) Watch your steps : actively engage and promote physical activities: walking, using stairs, 

taking active breaks and movements throughout the day. 

.(iv) Watch your stress level : Introduce stress consultation and counselling services for staff. 

.(v) Watch your change : 

.(vi) Watch your tobacco anf alcohol : 

.(vii) consumption 

 

 

………………………………………… BEST OF LUCK ………………………………………… 

 


